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1 Introduction 

ProHawk® Vision Server 
 
The ProHawk® Vision Server Administrators Guide provides an information and instructions for 
configuration and integration of the ProHawk Vision Server. We have tried to make this overview clear, 
easy to understand, and informative. We value the relationship that we have with our users and believe 
this guide with be valuable in expediting the setup of ProHawk Vision Server. 
 
ProHawk Vision Server receives video delivered by an RTP/RTSP stream. ProHawk Vision Server 

processes and clarifies the image, then will deliver it again as an RTP/RTSP stream. The CODEC of video 

corresponding to reception and distribution is limited now to H.264 only. ProHawk Vision Server provides 

a browser-based management console to setup and configure the ProHawk Vision Server. ProHawk 

Vision Server provides an operator’s console with various parameter controls that can be changed by 

accessing the ProHawk Vision Server Client user Interface with a web browser. There is a current 

limitation in if the RTSP video it receives contains sound; ProHawk Vision Server will not deliver the sound 

with the improved video stream.  

This is the 6.0.0 release of ProHawk Vision Server. 
 



 

2 System Requirements

Following are the systems requirements for ProHawk Vision Server to operate properly: 
 

• 64-bit Multicore CPU 

• 8GB RAM (16GB or more recommended; 2GB per stream recommended) 

• Windows 10, Windows Server 2012, Windows Server 2016, Windows Server 2019, Ubuntu 

18.04.3 LTS, Ubuntu 20.04.1 LTS 

• NVIDIA Quadro, Tesla, GRID, GeForce or RTX products with Kepler, Maxwell, Pascal, Turing, Volta 
or Ampere generation GPUs 

ProHawk Vision Server includes and requires the following external libraries: 
 

• Microsoft Visual C++ 2015-2019 Redistributable (x64) runtime 

• Microsoft .NET Framework 4.8 Redistributable 

• OpenCV 4.4.0 

• NVIDIA CUDA 11.0 

ProHawk Vision Server supports 64-bit (x64) architectures and 64-bit ARM architectures. ProHawk Vision 
Server does not support 32-bit (x86) architectures. 
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3 Directories & Files 

There will be several directories created after extracting the ProHawk Vision Server setup into the 
C:\Program Files\ProHawk\Vision Server main folder. Following are the folders and their descriptions: 

Folder Description 

docs Documentation files: ProHawk Vision Server Users Guide.pdf. 

VisionServerClientService A folder containing the ProHawk Vision Server client and associated files. 

VisionServerService 
A folder containing the ProHawk Vision Server web server service and 
associated files. 

Web Runtime client web page files. 
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4 Genetec Integration 

This section covers the basic integration of ProHawk Vision Server. Before running ProHawk Vision Server 
you must make sure the ProHawk Vision Server service is running first. The ProHawk Vision Server service 
is setup at install and automatically configured to start when the system boots up. 
 

 Validate Service Setup 

To check the status of the ProHawk Vision Server service, type “services” into the Windows search, and 
hit the Enter key. Below shows the Windows Services window with the ProHawk 
VisionServerServiceManager highlighted in Blue. The VisionServerServiceManager Status should be 
“Running” and the Startup Type should be “Automatic”. (Figure 1) 
  

 
 

 ProHawk Vision Server Service Manager 

Once the service is running, you can run the ProHawk Vision Server Manager to configure the camera 
streams.  You can run the ProHawk Vision Server Manager by either clicking on the start menu (Figure 
2), or enter localhost:44325/visionservermanager.aspx into the browser (Figure 3) 
 

Figure 3 

Figure 3 

Figure 1 

Figure 2 Figure 3 
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 Service Manager Page 

There are five main sections in the ProHawk Vision Server Service Manager: Configuration Settings for 
a camera stream, Configuration Settings for the Server, Manage Camera Configurations, Status, and 
Camera Control. Below (Figure 4) is the Vision Server Service Manager configuration page with the five 
sections are highlighted that contains all the settings held for each stream in a properties file. The 
default VDOT.PROPERTIES stream is in the  

C:\Windows\System\config\systemprofile\AppData\Roaming\VisionServerConfigurationFiles\ folder. 

This is provided to allow you to quickly test to see if the system is operational. To start the VDOT camera 
feed, select “VDOT” from the dropdown list from Available Streams. (Figure 5)   

 

Figure 5   

Figure  5   

Figure 4 



  

Page 9 of 37 

ProHawk Technology Group, Inc. 
Doc No: SVG513 

When VDOT is selected as the Available Stream, the Configuration Settings section will contain the 
camera streams configuration seen below. (Figure 6)   

 Camera Connection Settings 

This is the configuration information of the camera stream to be restored by ProHawk Vision Server. 
Below shows the Camera Connection Settings windowpane highlighted. (Figure 7) 

 

4.2.2.1 Camera/Stream Name 

The Camera/Stream Name of the RTSP 
stream output by ProHawk Vision Server 
service. If the stream name is omitted, it is 
automatically set to "stream". When set to 
"stream", connect to the rtsp://<IP address 
of PC where ProHawk Vision Server 
operates>/stream from an external 
application such as VLC. This is the same as 
the rtsp_server.name in the camera streams 
configuration properties file. 
 

4.2.2.2 Auto Restart 

This checkbox, when enabled (checked), 
automatically starts the camera stream 
when the Vision Service starts. 
  

Figure 7 

Figure 6 
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4.2.2.3 URL 

The URL of the RTSP camera to connect to the ProHawk Vision Server service (e.g. 
rtsp://192.168.1.42/axis-media/media.amp) If this setting is omitted, the ProHawk Vision Server web 
server will not start. This is the same as rtsp_client.url_to_connect in the camera streams configuration 
properties file. 
 

4.2.2.4 Username 

The Username for the camera authentication with the ProHawk Vision Server service when connected. 
The setting can be omitted if there is no authentication. This is the same as the rtsp_client.username in 
the camera streams configuration properties file. 
 

4.2.2.5 Password 

The Password for the camera authentication the ProHawk Vision Server service. The setting can be 
omitted if there is no authentication. This is the same as the rtsp_client.password in the camera streams 
configuration properties file. 
 

 H264 Settings 

This is the configuration information of the 
output stream format for the ProHawk Vision 
Server service. Below highlights the H264 
Settings. 
 

4.2.3.1 Bitrate 

The bit rate (unit:bps) for encoding H.264 
output video stream with the ProHawk Vision 
Server. If the bit rate is omitted, it is 
automatically set to “5000000”. This is the 
same as setting file H.264 encode bitrate. 
(Figure 8) 
 

4.2.3.2 Custom Settings

The Custom Settings dropdown list contains 
pre-defined bitrate for the associated 
resolution and framerate of the video. 
 
 
 
 
 
 
 
 
 

Figure 8 
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 WEB Connection Settings 

This is the configuration information of the 
ProHawk Vision Server Manager service. 
Figure 9 to the right highlights the WEB 
Connection Settings.  
 

4.2.4.1 Port Number 

The web server port number for connecting 
to the ProHawk Vision Server Manager User 
Interface. If the port number is omitted, it is 
automatically set to “44325”. This is the same 
as the web_server.port in the configuration 
properties file. (Figure 9) 
 
 
 
 
 
 
 
 
 

 Server Configuration Settings 

This is the configuration information of the 
restored video stream output by the 
ProHawk Vision Server service. To the left 
highlights the RTSP Publishing Settings 
section. (Figure 10) 
 

4.2.5.1 RTSP Port 

The distribution port of the RTSP stream 
output by the ProHawk Vision Server service. 
If the distribution port number of the RTSP 
server is omitted, it is automatically set to 
“554”. If it is set to other than 554, for 
example 55400, connect to the URL 
rtsp://<IP address of PC where the ProHawk 
Vision Server operates >:55400/Camera 
Name for external application such as VLC. 
This is the same as the rtsp_server.port in the 
camera streams configuration properties file. 
(Figure 10) 
 

 

Figure 9 

Figure 10 



 

 

 Manage Camera Configuration 

The Manage Camera Configuration is the section to manage the camera stream to be restored by 
ProHawk Vision Server service. The ProHawk Vision Server Management Controls include: 
 

• Save Camera Configuration 

• Delete Camera Configuration 

To the right shows the Camera Management 
Controls for a configured and saved camera 
configuration. (Figure 11) 
 

4.2.6.1 Save Camera Configuration 

Click on the Save Config icon to save the 
configuration settings for a camera stream. 
The saved configuration becomes effective 
after Start Selected Stream in performed.  

 

4.2.6.2 Delete Camera Configuration 

Click on the Delete Config icon to delete the 
Active Camera Configuration on the ProHawk 
Vision Server service. 

 

  

  

Figure 11 
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 Camera Control 

The Camera Control section provides a list of the active camera streams to start and stop computer vision 
restoration. It also provides a list of active cameras or streams that are being restored with ProHawk 
Vision, and a small preview window of the camera stream. It also provides the management address URL 
for the ProHawk Vision Server. (Figure 12) 
 

4.2.7.1 Servers 

The Camera Control section contains a Servers panel, that contains a list of the 
ProHawk Vision Server(s) on the network. The list contains the URL to access 
and control a ProHawk Vision Server, including the IP address and port number. 
(Figure 13) 
 
 

 
 
 
 
 
 

4.2.7.2 Controls 

The Controls panel in the Camera Control section provides a dropdown list of 
cameras and/or streams with buttons to start and stop ProHawk Vision 
restoration processing. (Figure 14) 
  

Figure 12 

Figure 13 

Figure 14 
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4.2.7.2.1 Camera 

The Camera control provides a dropdown list of cameras and/or streams to 
start and stop ProHawk Vision Server restoration processing. Click on the 
Cameras Dropdown list to display the Active Streams available to the ProHawk 
Vision Server service. To the right shows the list of Active Streams that are 
available. On initial installation, there will only be the VDOT stream. As you 
add more streams, they will become available in this list. Select a 
camera/stream on the Cameras Dropdown menu list. (Figure 15) 
 
 

 
 

4.2.7.2.2 Start Button 

Once a camera or stream has been highlighted and selected from the Cameras 
Dropdown list, click on the Start Button icon to begin a restoration processing 
on the camera or stream. (Figure 16)  
 

4.2.7.2.3 Active Streams & Preview 

 
Once the camera/stream is selected, to the right you 
will see the Active Stream populated and the live 
stream Preview Pane will display a thumbnail stream. 
(Figure 17) 
 
 
 
 

4.2.7.2.4 Stop Button 

When a camera or stream is processing, and you want 
to stop ProHawk Vision Server restoration, click on the 
Stop Button icon to stop the Active Stream on the 
ProHawk Vision Server service. (Figure 18)  
 
A browser popup window will ask you to confirm stopping the stream. Click on 
the OK button to confirm stopping the stream. (Figure 19) 

Figure 17 

Figure 18 

Figure 15 

Figure 16 

Figure 18 
Figure 19 
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5 ProHawk Vision Server Client 

Once you have a stream activated in the Vision Server Manager, you will be able 
to run the ProHawk Vision Server Client without issue. The ProHawk Vision Server 
Client provides a preview of the video camera stream and the controls for 
enhancing the video. You can open and run the ProHawk Vision Server Client by 
either clicking on the start menu (Figure 20), or enter 
localhost:44325/rtspclient.aspx into the browser (Figure 21)  
 

 
  

Figure 21 

Figure 10 



  

Page 16 of 37 

ProHawk Technology Group, Inc. 
Doc No: SVG513 

 ProHawk Vision Server Client User Interface 

Once you have successfully accessed the ProHawk Vision Server Client, below shows the five main 
sections to the ProHawk Vision Server Client User Interface: (Figure 22) 
 

1. Menu Bar 
2. Camera Selection 
3. Camera Preview 
4. Vision Server Restoration Parameters 
5. Custom Filters 

2 

3 

4 
 

5 

Figure 22 

1 
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 Menu Bar 
ProHawk Vision Server Client provides a menu bar for quick navigations that conserves more vertical 
space for the user interface. People are also accustomed to reading left to right across a screen, so the 
horizontal menu bar is efficient for users to read. 
 

 View Menu 

The ProHawk Vision Server Client provides several viewing options accessible through the View menu 
(Figure 23). The available View menu options and their default View options settings are: 

• Enhanced View - On 

• Side-by-Side View - On 

• External Enhanced View - Off 

• Unenhanced External View – Off 

This section of the ProHawk Vision Users Guide will describe the View menu options above in Figure 23.  

Figure 23 
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5.2.1.1 Enhanced View 

The View menu Enhanced View menu option is turned On by default. (Figure 24) The Enhanced View 
menu option toggles the ProHawk Vision restoration filter On and Off. When the Enhanced View menu 
option is selected, it will toggle the Enhanced View menu option Off. 

Figure 24 
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5.2.1.2 Side-by-Side View 

Once the video stream is selected, ProHawk Vision will simultaneously display both the original (source) 
stream on the left and the restored (enhanced) stream on the right. The example below shows how the 
user interface displays the imagery side-by-side. (Figure 25)  

5.2.1.3 Enhanced External View 

The ProHawk Vision Server Client provides the Enhanced External View, View menu option, to open a 
separate window with only that ProHawk Vision Server restored imagery displayed. Click on the 
Enhanced External View, View menu option. This will allow you to view a ProHawk Vision restored video 
stream in full screen mode. (Figure 26)  

Figure 25 

Figure 26 
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Choosing this option will open 
another tab with a full-sized 
image of the enhanced 
stream.  Since it is on another 
tab, you can move the tab to a 
new window. If multiple 
screens are available, the new 
window can be on the second 
monitor. You can create a new 
tab for both the Enhanced 
External view and the Original 
External view.  (Figure 27) This 
view allows you to enlarge or 
reduce the image/stream size 
using the magnifying icons on 
the upper right. 

5.2.1.4 Original External View 

ProHawk Vision provides the Original External View, View menu option, to open a separate window 
with only that original imagery displayed. Click on the Original External View, View menu option. This 
will allow you to view a ProHawk Vision original video stream in full screen mode. (Figure 28) 
 

 
 
 

Figure 36 

Figure 27 

Figure 28 
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 Options Menu 

The ProHawk Vision Server Client provides several viewing options accessible through the Options menu 
(Figure 29). The available Options menu options and their default View options settings are: 

• Disable Enhancement Off – On 

 
Figure 29 

 

5.2.2.1 Disable Enhancement Off 

The Options menu Disable Enhanced Off, Options menu option is turned On by default. The Disable 
Enhancement Off menu option toggles the ProHawk Vision restoration filter On and Off. When the 
Disable Enhancement Off menu option is selected, it will toggle the Disable Enhancement Off menu 
option Off. 
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 Camera Selection 
The Stream Selection section contains buttons with the names of the camera streams that have been 
setup in the ProHawk Vision Server Manager. To view and restore a stream, click on the button with the 
name of the stream you want to view and/or restore. The VDOT buttons is present, but if more streams 
were invoked, they would be listed right below the VDOT button. (Figure 30) 
 
  

Figure 30 
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 Camera Preview 
The Stream Preview provides a real-time view of the original video stream and the restored video 
stream, in a side-by-side view format seen below. (Figure 31) 
 
  

Figure 31 
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 Vision Server Restoration Parameters 

 

 Presets Conditions 

The Presets Conditions radio buttons allow for quick results based on a range of preconfigured settings 
to meet a variety of conditions. One-click on any of the radio button instantly restores the video stream 
to the challenging visual condition. Below highlights the Preset Conditions that ProHawk Vision Server 
can accommodate. (Figure 32) 
 
 
  

Figure 32 
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Following are the details on each preset condition. 
 

5.5.1.1 Rain 

Preset for improved visibility in footage shot in 
the rain. 
 

5.5.1.2 Snow 

Preset for improved visibility in footage shot in 
snowy weather conditions. 
 

5.5.1.3 Fog 

Preset for improved visibility in footage shot in 
the fog. 
 

5.5.1.4 Dirt 

Preset for improved visibility in footage shot in 
the dirt. 
 

5.5.1.5 Sand 

Preset for improved visibility in footage shot 
during a sandstorm. 
 

5.5.1.6 Night 

Preset for improved visibility in footage shot in 
the night. 

5.5.1.7 Lowlight 

Preset for improved visibility in footage shot in 
low light conditions. 
 

5.5.1.8 Backlight 

Preset for improved visibility in footage shot 
with excessive backlight. 
 

5.5.1.9 Headlight 

Preset for improved visibility in footage shot 
with excessive headlight. 
 

5.5.1.10 Sunglare 

Preset for improved visibility in footage shot 
with too much sun glare. 
 

5.5.1.11 Infrared 

Preset for improved visibility in footage shot in 
infrared. 
 

5.5.1.12 Underwater 

Preset for improved visibility in footage shot 
underwater. 
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 Detail Parameters 

The Detail Parameters are the individual restoration capabilities that ProHawk Vision Server supports. 
These are specific adjustments that may have an impact on details to be revealed. Many times, when 
looking for specific details in compromised imagery or video, these parameters can be individually 
adjusted to achieve hidden details. ProHawk Vision Server Detail Parameters allows the user to adjust 
the ProHawk parameters individually. (Figure 33) 

 
 
 
  

Figure 33 
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 Resolution 

The Resolution parameter setting controls how the ProHawk Vision Server service will process video 
according to the resolution of the source device or desired restoration results output by the system.  
 

5.5.3.1 Sharpening 

Sharpening specifies the range to be referred to from the pixel to be processed in radius (pixel). 
Sharpening considers the width and height of the radius of processing range of the ProHawk Vision 
Server. The smaller the setting is, the clearer the contrast for details will become, but it will result in a 
painting-like image as the contrast for the entire screen is averaged.  Generally, set it low to emphasize 
small parts and fine details, or high if natural image quality is desired, or when there is too much noise.  
Set it in the middle under normal circumstances for a 1080p video. Set it lower between 20-30 for SD 
480p-720p video. Set it higher between 128-256 for UHD 4K-8K video. Set higher to increase Edge 
Sharpening for computer vision and analytics applications.  
Range: 1-256 (Figure 34) 
 

  

Figure 34 
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 Detailed Restoration 

The Detailed Restoration parameters for the ProHawk Vision Server service enable fine tuning and 
revealing details in hidden areas of video. (Figure 35) 

5.5.4.1 Tone Effect 

The Detailed 
Restoration Tone 
Effect parameter 
expands the 
luminance range of 
the ProHawk Vision 
Server service. The 
Detailed Restoration 
Tone Effect is for 
adjusting the contrast 
of the Tone Effect. It is 
available if the 
Contrast Brightness 
parameter is turned 
OFF.  
 
Set the Detailed 
Restoration Tone 
Effect to 0 under 
normal conditions, 
gradually increase it 
until optimal results 
achieved. When the setting is high, it may cause fuzzy outlines to appear more noticeable on top of 
buildings into the sky. When it is set low to 0, it does not expand the luminance range. When it is set 
high to 256, it will expand the luminance range to the maximum capacity of the ProHawk Vision Server 
service. 
Range: 0-256 
 

5.5.4.2 Histogram Ratio 

Detailed Restoration Histogram Ratio adjusts the ratio/percentage for combining the input image and 
histogram image. The Detailed Restoration Histogram Ratio parameter adjusts the level of ProHawk 
Vision Server service restoration effect.  Images and video are improved in low contrast situations such 
as fog, rain, or snow, and in situations of too much contrast such as backlight or direct sunlight, or in 
darkness at night. The higher the setting is, the clearer the contrast will become, but the noise may also 
increase.  This parameter specifies the Detailed Restoration Histogram Ratio between the original image 
and the processed image. Set it at 128 (50%) under normal circumstances. When set to 256, the image 
is processed by the ProHawk Vision Server service 100%. The Detailed Restoration Histogram Ratio 
defaults to 0. 
Range: 0-256 
 

 

Figure 35 
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 GPU Capacity 

The GPU Capacity parameters provide adjustment, see below, for optimal operation tuned to the 
capacity, throughout, and performance of the NVIDIA GPU being used. (Figure 36) 

5.5.5.1 DEF Divide C 

Divide Circle is the 
number of divisions of 
circles in the Vision 
Filter processing 
range. Specify how 
many divisions are to 
be referenced from 
the processing target 
pixel to the radius 
specified by Radius. 
The number of 
divisions and 
processing time are 
proportional. 
Typically, 8 is the 
optimal setting, but in 
some cases where the 
video has many 45-
degree lines, the 
image quality can be 
improved by setting to 
an odd number. 
Range: 3-16 
 

5.5.5.2 DEF Divide R 

Radius is the number of divisions of radius of processing range of the ProHawk Vision Server service. 
When referring to the pixel to be processed, it specifies how many surroundings to divide. The number 
of divisions and processing time are proportional. 
Range: 1-16 
  

Figure 36 
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 Contrast 

The Contrast parameters provide for adjustment to the contrast of the ProHawk Vision Server service. 
(Figure 37) 

5.5.6.1 Sensitivity 

Contrast Sensitivity 
limits the luminance 
range of the ProHawk 
Vision Server service. 
Set to a lower 
number reduces the 
level of residual 
image effect due to 
movement 
compensation.  This 
is a threshold to 
recognize an object 
as a moving pixel(s).  
The Contrast 
Sensitivity parameter 
defines the distance 
allowance between 
the adjacent pixels 
(for example, 
luminance 10 and 
luminance 11 
becomes luminance 
15 by the ProHawk 
Vision Server service…the distance 5 is calculated from the luminance 10) limiting the slope of the 
brightness fluctuation amount. This parameter allows for local contrast adjustments to the imagery 
enabling higher contrast viewing. Set it at 16 under normal circumstances.  
 
Decrease the Contrast Sensitivity value if random noise is noticeable in the video. When the Contrast 
Sensitivity setting is lower, the ProHawk Vision Server service becomes more sensitive to changes and 
residual image is reduced, but with less noise elimination effect.  Raise the Contrast Sensitivity setting 
higher to obtain better contrast or if contrast is insufficient. If the video is dark, the setting should be 
turned higher. When the setting is higher, the ProHawk Vision Server service becomes less sensitive, and 
with more noise elimination effect, yet residual image would become more noticeable. If it is dark and 
noise is conspicuous, reduce the Contrast Sensitivity to between 8 to 12, while also increasing the 
Contrast Brightness. When the Contrast Sensitivity is set to 256, the Tone restoration is turned OFF, 
Contrast Brightness and Detailed Restoration Tone Effect are disabled.  
Range: 1-256 
 

Figure 37 
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5.5.6.2 Brightness 

Contrast Brightness changes the luminance range of the ProHawk Vision Server service. Contrast 
Brightness is for automatically adjusting the brightness of the tone effect according to the screen area. 
In typical use cases, unless there is conspicuous noise, set the Contrast Brightness to automatic by 
selecting the Auto checkbox. This overrides the Contrast Brightness slider bar, adjustment is automatic. 
 
When Contrast Brightness is ON and Contrast Sensitivity is set low for dark video that is noisy, the entire 
screen is adjusted by a fixed brightness. When Contrast Brightness is set in the middle to 128, the 
ProHawk Vision Server service will adjust brightness by 50%. 
Range: 0-256 
 

 Noise Reduction 

The Noise Reduction parameters reduce or remove noise from compromised videos. (Figure 38) 
 

5.5.7.1 Histogram Brightness 

Noise Reduction 
Histogram Brightness 
adjusts the 
ratio/percentage 
brightness 
information for 
combining the 
ProHawk Vision 
Server service 
processed image and 
histogram image. The 
parameter adjusts the 
ratio versus the 
histogram. The larger 
the number, the more 
impact the histogram 
produces on the 
result by 
accumulating more 
processed images. 
When set to 0, it will 
adjust the ProHawk 
Vision Server 
processed image 100%. The Noise Reduction Histogram Brightness parameter default is 0. 
Range: 0-256 

 

 

Figure 38 
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5.5.7.2 Histogram Motion 

The Noise Reduction Histogram Motion parameter adjusts the level of residual image reduction effect 
due to movement compensation.  This is a threshold to recognize an object as a moving pixel(s).  When 
the setting is lower, the ProHawk Vision Server service becomes more sensitive to changes and residual 
image is reduced, but with less noise elimination effect.  When the setting is higher, it would become 
less sensitive, and with more noise elimination effect, yet residual image would become more 
noticeable. Specify parameters for reducing noise by adapting to the motion of the image. 
 
In most conditions, setting ProHawk Vision Server service between 1024-3072 works well. On a fixed 
camera/sensor, decrease ProHawk Vision Server service to detect moving objects, and increase Noise 
Reduction Histogram Brightness. The Noise Reduction Histogram Motion should always be ON if Noise 
Reduction Histogram Brightness is ON under normal circumstances. The setting of Noise Reduction 
Histogram Brightness ON and Motion Adaptive Threshold is OFF should be used only when it is desired 
to remove the movements of snow or rain, etc. using a fixed camera. 
Range:0-256 
 

 Color Adjustment 

The Color Adjustment parameter reveals vivid color in dark video scenes. (Figure 39) 

 

5.5.8.1 Saturation 

Color Adjustment 
Saturation changes 
the magnification in 
the ProHawk Vision 
Server service. The 
Color Adjustment 
Saturation parameter 
adjusts the level of 
the ProHawk Vision 
Server service color 
correction effect. 
Turn the Color 
Adjustment 
Saturation ON under 
normal circumstances 
with slight color 
correction. 
 
It may be turned OFF 
if it becomes difficult 
to see the image with 
color restoration 
when the entire screen has color such as being in the ocean, etc. Set it higher temporarily to check color 
only when it is difficult to recognize color in video due to a dark video or a foggy video. Specify 

Figure 39 
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parameters for emphasizing color information that tends to be lost due to sharpening. When ‘Enable’ is 
checked, the color restoration function is enabled. The Color Adjustment Saturation parameter defaults 
to 0. 
Range: 0-512 
 

 Off 

Reset all video parameters to the default Off state. 
 

5.5.9.1 Custom Filters 

The Custom Filter option allows you to create a re-usable filter, based on any of the Presets and adjusting 
any of the sliders to determine what the filter does. (Figure 40) 

Once you have modified the restored stream to your liking, create a name for your filter and click on the 
Save button. (Figure 41) 

You will then see that your filter has been added to the list of Custom Filters. If you then select one of 
the filters, the restored stream will then display the changes.  To reset the stream, simply click on any of 
the presets. (Figure 42) 

 
 
 
 
 
 
 

Figures 42 

Figure 40 

Figure 41 
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Figure 44 

6 License Key Update 

The ProHawk Vision Server License Key Update program allows you 
to upgrade and update your license key. To access the ProHawk Vision 
License Key Update program, click on the ProHawk Vision Server 
License Key Update, Start Menu option. This will run the ProHawk 
Vision Server License Key Update application. (Figure 43) 

 License Key 

Enter the 25-character license key, then click the Next > button. 
(Figure 44) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Product Registration 

Fill in the registration information 
form, then click the Close button to 
complete. (Figure 45) 

Figure 43 

Figure 45 
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7 Uninstaller 

This section covers the removal of ProHawk Vision Server application from your computer. 

 Initiate Uninstaller 

To begin the uninstaller, go to your Windows Settings/Apps & Features. Select the ProHawk Vision 
Server v5.1.0. Then select the Uninstall button. (Figure 46) 

  
Figure 46 

You will be prompted by Windows “This app and its related info will be uninstalled.” Click on the 
Uninstall button. (Figure 47) 

  
Figure 47 
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 Confirm Uninstall 

To confirm uninstall, click the Yes button in the prompt that displays.  If you do not wish to uninstall click 
the No button. (Figure 48) 
 

  
Figure 48 

 Uninstalling 

An uninstall dialog will appear after confirming uninstallation.  Wait for uninstaller to finish running its 
processes.  If you wish to end the uninstallation at any time you may click the Close or Cancel button. 
(Figure 49) 
 

 
Figure 49 
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 Firewall Rule Removed 

The uninstaller will notify with a dialog will tell you that ProHawk Vision Server rule has been 
successfully removed from your systems Windows Firewall.  Click OK to continue the uninstallation. 
(Figure 50) 

 
Figure 50 

 Configuration Information Removal 

The uninstaller prompt with a dialog to ask you if you want to completely remove the ProHawk 
Vision Server configuration information.  Click Yes to remove the configuration information or 

Click No to preserve the configuration information. (Figure 51) 

 
Figure 51 

 Finish Uninstalling 

When the uninstaller is finished a dialog will tell you that ProHawk Vision Server has been successfully 
removed from your system.  Click OK to finish the uninstallation. (Figure 52) 

  
Figure 52 

 


